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iCIinical Trial Center Aachen (CTC-A)

m Re-established (Nov. 2010)

> Self standing unit i "'Ak i .
RWTH Aachen University ak i |
Medical School (Uniklinik) CTC-A |

= Mission e

> Improvement of study outcome (scientific, economic)
» Support of investigator initiated trials (I1T)
> Quality management

m Methods

» Process re-structuring & controlling
» Software (GWT, Dept. of Med. Informatics)
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m Uniklinkk RWTH Aachen, Medical School

tructure

» Clinical Trial Center Aachen (CTC-A)

» Dept. Medical Informatics (IMI)

= Uniklinkk RWTH Aachen, Hospital
> IT Dept. (UKA)

= RWTH Aachen University
> IT Dept. (RKZ)

CTC-A

beauftragt

UKA

berat

IMI

beauftragt

RKZ
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tructure

Internet
Browser |
 CTC-A
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(Open Clinica) _S_tufe 5/ (TMF PID) (GWT)
6CRFs Personal Access Stuo!y
. ID protocol admin
o IMI
A 4 E i {V \ 4
Backup Backup Backup Backup
(TSM) (TSM) (TSM) (TSM)
| . RKZ
Ausbaustufe 4 a Ausbaustufe 3 Ausbaustufen 1 & 2
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TC-A Study Management Tool

@ CTC-A Project Management Database - Mozilla Firefox EI@
Datei Bearbeiten Ansicht Chronik Lesezeichen Extras Hilfe
@ ~ C X & [F nttpy//134.130.12.190:8080/StudyManagement_20110923/ 7 - | ™~ imagel invert IR
£, Meistbesuchte Seiten [.| Wiley-Physics r1 RWTH L2P Physics BVMZ2011 Springerlink - CSRD (0] IMI Web Access [#] CTC-A 2.1.0 H American Express Platin... | | CTC-A local [#] CTC-A Test »
[#] CTC-A Project Management ... | + -
CTC-A223 Study
Department Person Function
t\ll]{[‘i"\‘lll l please select ™| | Clear please selec ™ | | Clear please select ™ | | clear
g_c,-:"A_m |1 Seite 1 voni1s b Bl & Anzeige Eintrag 1 - 22 von 384 Edit Study New Study
Shortname CTCA-No - Sponsor CRO Status Fonds ClinTrial EudraCT Ethicz-Ref. ANG MPG BOANRW
vy Vortrag_ROC_Deserno ML001 » Other (] [} [}
Person Leitung KKS vd KKS-Generak001  MK1 » Other [} ] ]
Department NeuroDB M-11-065 Meurologie » Other (=] (=]
p— OpenClinica m-11-062 CTC-A M » Other [} =] =]
; GWT-PMD IT-10-045 CTC-A (] » Other (] [} [}
Patient NACHFOLGE MeDiNa GB-FM-35 CTC-A » Other (] [} [}
Report Medizin. Technik. NRW GB-FM-34 » Other (] [} [}
ADHS-EEG GB-FM-33 » Other (] [} [}
Chart PA-10-067 GB-FM-32 » Other [} (=] (=]
Dashboard Risk AGUA GB-FM-31 » Other 350616 =] =] =]
Spende Eggermann GB-FM-30 » Other |:| |:| |:|
Help HUMTHAL GB-FM-29 » Other (] [} [}
New Window DFG -Bei Wu GB-FM-28 » Other (] [} [}
BRA 09/045 GB-FM-27 » Other 350456 (] [} [}
Bug-Repart MIF-Sekretion GB-FM-26 » Other [} =] =]
Logout Coburn-Baxter GB-FM-25 » Other (] [} [}
YB-1 GB-FM-24 » Other ] ] ]
Epiglu GB-FM-23 » Other (] [} [}
DFG-Oplinder GB-FM-22 » Other (] [} [}
Syntab GB-FM-21 » Other (] [} [}
restless legs GB-FM-20 » Other 374005 [} ] ]
Sik-Bladder GB-FM-19 » Other 360602 [} (] (]
[
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TC-A Study Management Tool

eﬁ CTC-A Project Management Database - Mozilla Firefox EI

Datei Bearbeiten Ansicht Chronik Lesezeichen Extras Hilfe
@ p C 4 ([ httpy//134.130.12.190:8080/StudyManagement_20110923/ 77 - | [*8- Google £ 3R
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- cl .
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rimary Origins & Interchange

CTC-A OpenClinica
m Data m Data
» Name of study m—)
> Study sites m—)
» Persons, roles, access levels s=p-
» Development of patients <= > Current number of patients

(FPI, LPO, History)
<= > |Mages

= Function = Function
>» Image processing G > Call

m Data m Data
>» Result images m—)
» Result measurements m—)
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references

= Maintain OC code
» Compatibility
» Updates

= Full integration
» Data
» Function

m Automation
> NoO user interaction

m Use standards
» Communication
» Data Interchange

m Data security

m Thomas M. Deserno

4 GWT Application Server A Internet OpenClinica Server A
\ ExtGWT Application ) i oc
| Ccorver 1 WS
erver
( | \ / :
w o — f
WS SOAP p
erver [~
\_ : ) T JavaScript \ oc
\,‘\ _______ \  Core
. Excel eCRF
Java Image Analysis \ |
MySQL DBMS PostgreSQL DBMS
Data File File Data
Base System System Base
“-/7 \“
T /' 2 get ﬁ\
FTP ( Client SFTP Server) FTP
. 1 J put \. 1 J
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iOpenCIinica Excel eCRF Definition

m Concept
» JavaScript enhancement
» Sends SOAP messages

= Problem
» “Cross Domain Calls”
> Not allowed to execute client JavaScript code on server

m Solution
» PHP proxy server
» Creates SOAP message
» Calls OpenClinica web services
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mplementation

J S . t 1 <script>

B JavaoCript -
3 function callPHPProxy () {
4
5 // Prepare PHP proxy call
6 xmlhttp = new XMLHttpRequest() ;
7 xmlhttp.open('GET', 'http://oc-server/phpproxy.php?imageID=42"', true);
8
9 // Send request
10 xmlhttp.send(null) ;
11 }
12 </script>

m PHP Proxy[: <=
2
3 // Get parameters
4 $imageID = ($ POST['imageID']) ? ($ _POST['imageID'l) : ($_GET['imageID']) ;
5
6 // Create SOAP client
7 $client = new SOAPClient ('http://gwt-server/image?wsdl') ;
8 $client-> setLocation('http://gwt-server/image') ;
9
10 // Invoke SOAP method
11 S$client->startImageAnalysis(array('imageID' => $imagelD)) ;
?2>
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i’mage & Measure Transfer

m JCraft Java secure channel library (JSch)
» SFTP connection
» Data transfer (get)
» ... Java code execution
» Data transfer (put)

m Web Service
» OpenClinica Web Server
» CTC-A Client
» Well-formed XML file

» Clinical Data Interchange Standards Consortium
Object Data Module (CDISC ODM)
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mplementation

m Java code

® T 00w N

10

12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34 }

public String startImageAnalysis(String imageID) {

// Create JSch SFTP object
JSch jsch = new JSch();

// Configure session

Session session = jsch.getSession("user", "oc-server");
session.setConfig("StrictHostKeyChecking", "no");
session.setPassword ("password") ;

session.connect () ;

// Configure channel

Channel channel = session.openChannel ("sftp") ;
channel . connect () ;
ChannelSftp sftpchannel = (ChannelSftp) channel;

// Get image
sftpchannel .get (filename, local filename) ;

// Call Java module
callJavalImageAnalysis() ;

// Transfer result image back
sftpchannel.put (local result filename, result filename)) ;

// Close channel and session
sftpchannel .exit () ;

session.disconnect () ;

// Trigger JAX-WS to send SOAP message with results
sendSOAPResults () ;

return "Success!";

Thomas M. Deserno
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RWNTH

Dept. of Medical Informatics 12




Communication Protocols & Workflow

m Color scheme

OC Core

» Red: OpenClinica g | ) S

JavaScript User
> Blue: CTC-A (o EZE

J'SAe?(r_vVgrs FTP Server
» Green: Internet (RPC) _—
Java Image Query

File System \

Input Image

;
n

i FTP Client
Browser-based e Response
G U I Trigger, Store

JAX-WS

Client File System

()
(@)
>
o

m Example Workflow | wesuenenr:

» Conjunctival
provocation
teSt (CPT) KMetadata Transfer /

Result Image

FTP Client

Server
SFTP

OC Core FTP Server

K Image Transfer /

File System
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Result

m Single-sign-on
m CTC-A

>
>
>

study selection
metadata transfer
Image processing

m OpenClinica

Vi1 {4

>
>
>
>
>

subject selection
CRF selection
Image upload
Image display
Processing results

Thomas M. Deserno

f GWT Application Server h Internet f OpencClinica Server
1
. . 1
[ ExtGWT Application ] | oc
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/, Server
1
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li \
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= s s k ' 3 ! j
— ) — O\ ( PosItgre ]
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esult

o 1. Single-sign-on authentification

i Sl [ M1 Project Management Database 3.3.0 |+| =N

] 13413012.195:8080/StudyManagement e | |BY- Google P A& B~ = -

IMI Project Management Database Login

Username: deserno@ieee.org
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esult

o 2. CTC-A: study selection

@IMIProJectManagementDatabase330 | + | Ii“i“é‘
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IMI3.3.0 Study
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oL Carotis-Kurs. W5-03-12 Boston Scientific » Other Mone ] [} [}
| Person | 2 Intensivkurs Ws-02-12 DGNR » Other Mone ] [} [} Workshop DGNR
| Department | Stroke Workshop WS-01-12 DGNR » Other Mone [ E E Workshop DGNR
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| Patient | } -
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| Document | Tigrtraining TV-00-12 » Other Mone ] [} [}
| SOP | Test vor Mittags-Deploy test » Other Mone |:| |:| |:|
NRAD-Generak2012 NRAD-0000 » Other Mone 0 0 0
| Report | Vortrag_ROC_Deserno ML001 » Other Mone [} | |
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| New Window |
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| Logout |
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In2Wak GB-FM-25 » Other Mone BMBF 0 [ [
| Change User |
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| Send E-Mail | MicSurf GB-FM-94 » Other Mone AF ] [} [}
| searchPat. | SysmedIBA GB-FM-93 » Other MNone 360686 EU &= ] ]




esult

o 3. CTC-A: metadata transfer to OpenClinica

.IMIProJectManagementDatabase330 | + |

oSl

St 134.130.12.195:8080/5tudyManagement
IMI3.3.0 Stuehe
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esult

o 3. CTC-A: metadata transfer to OpenClinica

( ' .IMIProJect Management Database 3.3.0 .. | + | Ii“i“&l
St 134.130.12.195:8080/Studyly 8 - Google P HF B = -
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o 1
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p
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esult

m 3. CTC-A: metadata transfer to OpenClinica
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esult

m 3. CTC-A: metadata transfer to OpenClinica
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esult

o 4. Functional integration: switching to OpenClinica

@IMIProJectManagementDatabase330 | + | Ii“i“é‘
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esult

m 4. Functional integration: OpenClinica in a new tab

@ IMI Project Management Database 3.... I @ OpenClinica x| + E 3|

€ = S | @ 13413012129/0penClinica-web-3.1-SNAPSHOT/MainMenu 77 v & | |B- Google P A B = -
CPT (W5-0012) | Change Study/Site deserno_ieee_org (Monitor) en | Log Out i
.. ®
Gpgnch(rtt?a | Home | Subject Matrix | SDV | Notes & Discrepancies | Tasks « Report Issue | Support (iRt g(n] @l |
ommunity Ion

Alerts & Messages - |_
W i Welcome to CPT®
elcome to OpenClinica,

Thomas Deserno. You Notes & Discrepancies Assigned to Me: 0
last logged in on

06-Feb-2013.

| View By Event CR.F| | View By Study Subject ID

Source Data Verification

- 15 [=] | Show More | The table is sorted by Event Date
Instructions |_ Seleck: Al Shown, None

o TRt GIE N 1.ttt 1 st o] et e en o o e =0 Requremen [ St nctioms————
the study/site or request

access to a new study with a Apply Filter Clear Filter
different role.

m

Keine Eintrage gefunden.

Other Info - |_

[ sbmit W Cancel [N

Study: CPT

Start Date: NjA

End Date: N/A b
PL: Aachen, CTC-A

Protocol Verification/IRB
Approval Date:

Icon Key - |_

Statuses
Mot Started
= Scheduled

@ D
|

I ]

UNIKLINIK
RWTH -
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m 5. OpenClinica: subject selection
[ [=1m1 roject Monagement Detabase3... * | & OpenCiinica [+

€ St | @ 134130.12.129/0penClinica-web-3.1-SNAPSHOT/ListStudySubjects

o C'__' Google

CPT (W5-0012) | Change Study/Site

deserno_ieee_org (Monitor) en | Log Out
s s ®
Upean_lmt_:& | Home | Subject Matrix | SDV | Notes & Discrepancies | Tasks ~ Report Issue | Support EXTET=ad (o] [Gol |
Community Edition —
Alerts & Messages v |_
Instructions v] Subject Matrix for CPT @
Info v |_
Icon Key -L 15 [ | Show Mare || Select An Event [=] Add New Subject

Statuses
Mot Started IME001 Bjs
Scheduled o
@ Data Entry @ e
Started Ergebnisse 1 - 2 won 2.
@ Stopped -
@ Skipped
Completed
signed
Locked
Invalid
Actions
View
Edit
View All Icons
OpenClinica Portal Help  Contact © 2004-2011 OpenClinica, LLC and collaborators, The OpenClinica software for dinical research is provided AS IS, OpenClinica Community
without warranty, Licensed under LGPLv2., 1, you can redistribute it and/or modify it under the terms of the GMU Version: 3. 1-SNAPSHOT - Changeset:

Lesser General Public License version 2. 1 as published by the Free Software Foundation. OpenClinica is a trademark 4520559 194+ "2012-04-12 11:28
of OpenClinica, LLC. +0200"

Thomas M. Deserno Dept. of Medical Informatics
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m 5. OpenClinica: CRF selection

@ IMI Project Management Database 3.... I @ OpenClinica x| +

€ 9 S | @ 13413012129/0penClinica-web-31-SNAPSHOT/MainMenu 77 v ¢ ||~ Google P B~ ## -~
CPT (W5-0012) | Change Study/Site deserno_ieee_org (Monitor) en | Log Out =
. . ®
OpenClinica |

Home | Subject Matrix | SDV | Notes & Discrepancies | Tasks ~

Report Issue | Support |
Community Edition pal | Suppol Go|

Alerts & Messages

Welcome to OpenClinica,

Start Date: NjA
End Date: MN/A

PL: Aachen, CTC-A

Not Started

Scheduled

@ Data Entry
< [ -

CRFs in this Study Event:

~ L Enter or Validate Data for CRFs in Image Preview @

CRFName |Version
IMG Button 1.2

Status  Initial Data Entry

=

jagehlen

Double Data Entry Actions

A NE]
S

View this Subject's Record | Bat ]

Protocol Verification/IRB | —
Approval Date: Workflow - |
I I
Icon Key - |_ Sguf:rii\::t I_l | Data Entry |I_l | Mark Event CRF Complete |
Statuses

Thomas Deserno. You ol
last logged in on Edit Study Event
06-Feb-2013.
Study Subject ID IMGDO1
Study Event Image Preview
Instructions - |_ Location NjA h
j 55_IMGO01_9913
If needed you may change Study Subject 01D - =
the study/site or request
access to a new study with a Start Date 22-Jan-2013 P
different role. End Date/Time 3]
Subject Event Status data entry started
Other Info - |_
Last Updated by jagehlen (22-Jan-2013)
Study: CFT

LIS

Thomas M. Deserno

Dept. of Medical Informatics
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m 5. OpenClinica: image upload

@M Project Management Database 3... | [ OpenClinic Initial Dats Entry x|+ [ )
€ 9 S | @ 12413012129/0penClinica-web-3.1-SNAPSHOT/InitialDataEntry?eventCRFId=2&exit To=ViewStudySubjectid=2 77 v & || B~ Google P A B~ =~
Conjunctival Provocation Test 1.0 @ Test
¥ (CRF Header Info
Paﬁent_(3,|f3}|| Image U..(2/2) || Image A..(0/7) | » | — Selectio Jump — =]

Title: Patient Data

Instructions:

Page: [ Save W Bit N

- MName: Patient, Test e

2 Date of birth: 16-Aug-1972 fo

3 Sex: male fo

Return to top [ sove Qo JEI

b
- - NIKLINIK
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m 5. OpenClinica: image upload

o
M @ IMI Project Management Database 3.... I @ OpenClinica Initial Data Entry x| + E |23

€& > St | @ 123413012129/ OpenClinica-web-3.1-SNAPSHOT/InitialDataEntry?eventCRFId=2&isectionld=2&tab=2exit To=ViewStudySubject?id=2 syv ¢ ' Google P A B~ =~

Conjunctival Provocation Test 1.0 @ Test

¥ CRF Header Info

Patient...(3/3) || Image u_(o;2}|| Image A...(0/7) | - lw@

Title: Image Upload

Instructions:
Page: | save J  Bat NN

Contro:| [ Clickto uploadile | ™

RESDDHSE=| H Click to upload file ] L

Retumn to top [ save N bac__JE

UNIKLINIK
RWTH -
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esult

m 5. OpenClinica: image upload

@ IMI Project Management Database 3.... I @ OpenClinica Initial Data Entry

s

-

St | @ 13413012129/ 0penClinica-web-3 1-SNAPSHOT/InitialDataEntry?eventCRFId

x| + -]

I=28&sectionld=2&tab=28&exitTo=ViewStudySubjectfid=2

v ' Google

Al A B~ =~

Conjunctival Provocation Test 1.0 @ Test

v CRF Header Info

Patient...(3/3) || Image u_(o;2}|| Image A...(0/7)

| » | — Select to Jump — : |

Title: Image Upload

Instructions:

Page: [ save N Bat N

Control:|_1251822201302071326|[_Click to uploadfile | ™

Response:|_¢35182a201302071327| [_Click to uploadfile | ™

Return to top [ save _J  eqc _ JE
Lag’

Thomas M. Deserno
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m 6. OpenClinica: image display

s @IM] Project Management Database 3.... X]@OpenClinitalnhial Data Entry x|+ )
€ 9 SI | @ 13413012129/0OpenClinica-web-3.1-SNAPSHOT/InitialDataEntry?eventCRFId=28&isectionld=28&utab=2&exit To= ViewStudySubject?id=2 > v | |B)- Google Al A B =~
Conjunctival Provocation Test 1.0 & Test

¥ CRF Header Info

Image U..(2/2) || Patient..(0/3) Image U0 | » [ —Seectioump— ]

Title: Image Upload
Instructions: Please fill out all the questions and if an answer is unknown use the flag.

Page: T TS )

Control: _control20120806123838-0400.j10g ™

[Repliace|] Remove |

Replace I Remove |

UNIKLINIK
RWTH -
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esult

e @IMI Project Management Database 3.... ]@ OpenClinica Initial Data Entry x I o

¢ » s

m /. OpenClinica: result images and measurements

(B8 Bl

@ 134.130.12.129/0penClinica-web-3.1-SNAPSHOT/InitialDataEntry?eventCRFId=28&sectionld=28tab=2&exitTo=ViewStudySubject?id=2

Conjunctival Provocation Test 1.0 @
v CRF Header Info

Patient...(0 Image U..{0/2 Imange ..(7/7) | > |~ Seectio Jumo —

Test

=

Title: Image Analysis

Instructions: Please fill out all the questions and if an answer is unknown use the flag.

page: I Mark R Corpiete. TSNS N ()

response: ) result:

1 Image width: |3543 P (pixel)
2 Image heighth: |2735 ™ (pixel)
3 Control ROL: [107333 (%)

4 Control redness: [0 05255 Lo

5 Responsive ROL: [12.3183 P (%)

6 Responsive redness: [0.078512 Lag

7 Relative redness: |1‘494 1]

I mark CRF Complete (TN =" ')

¢ | |BY- Googte

Al e B # -

Thomas M. Deserno

Dept. of Medical Informatics
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Summary

m Workflow
> Automatic
>» Real-time ready

[ Data Entry Begin ]—-{ Study Selection '[ Meta Data Transfer]

Study + Users + Roles

\ 4

. . . Context
[ OpenClinica Login H eCRF Data Entry

N Signal File

Analysis Module | |

|

I Analysis :

: [ Analysis ]M{I Save Data H Data Entry End ]
| 1

Image File Upload ]

Thomas M. Deserno Dept. of Medical Informatics 30
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i%ummary

» Java code for image processing
» OpenClinica for eCRFs

m Data integration
» Web services (SOAP)
» CDISC ODM well-formed XML

m Functional integration
» JavaScript
» PHP proxy

= Workflow integration
» Single sign on

Thomas M. Deserno Dept. of Medical Informatics

= Image analysis for controlled clinical trials
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i’future Work

m [mprovements
> Browser refresh
» Open / close after automatic eCRF fill
» Image processing runtime

Synchronous vs. asynchronous transfer
m Extensions
» RIS / HIS interface (HL7, CDISC-LAB)

>» PACS interface (DICOM)
» Pseudonymization and randomization services

Thomas M. Deserno Dept. of Medical Informatics 32
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